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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Ctrl+clic ou clic droit se-
lon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T
Ouvre l’onglet Styles et Formatage du
volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr



Table des matières

Introduction..........................................................................................................................1

Premiers pas.........................................................................................................................1

Les formules dans les documents de LibreOffice.........................................................................1
Les formules en tant que documents indépendants.....................................................................2

Créer des formules..............................................................................................................3

Le volet des éléments..................................................................................................................4
Le menu contextuel.....................................................................................................................4
Le langage de balisage................................................................................................................5
Lettres grecques..........................................................................................................................6

Avec le langage de balisage....................................................................................................6
La boîte de dialogue Symboles...............................................................................................6

Unicode des caractères grecs.....................................................................................................7
Exemples de formules.................................................................................................................7

Exemple 1...............................................................................................................................7
Exemple 2...............................................................................................................................8

Éditer les formules...............................................................................................................8

Agencement des formules..................................................................................................9

Utilisation des accolages.............................................................................................................9
Parenthèses et matrices............................................................................................................10
Parenthèses non appariées.......................................................................................................11

Parenthèses de taille fixe......................................................................................................11
Parenthèses de taille variable................................................................................................11

Reconnaissance des fonctions...................................................................................................11
Formules sur plusieurs lignes....................................................................................................12
Ajout de limites aux commandes somme et intégrale................................................................12
Écriture des dérivées.................................................................................................................13
Caractères du langage de balisage employés comme caractères ordinaires............................13
Du texte dans les formules........................................................................................................14
Aligner les formules sur le signe égal........................................................................................15

Modifier l’apparence d’une formule.................................................................................15

Taille de la police d’une formule.................................................................................................15
Taille de la police de la formule en cours...............................................................................15
Taille par défaut de la police dans les formules.....................................................................16
Options de la boîte de dialogue Tailles de police...................................................................17

Polices des formules..................................................................................................................17
Polices de la formule en cours..............................................................................................17
Polices par défaut des formules............................................................................................18
Options de la boîte de dialogue Polices................................................................................18

Ajuster l’espacement dans les formules.....................................................................................19
Espacement de la formule en cours......................................................................................20
Espacement par défaut des formules....................................................................................20
Options de la boîte de dialogue Espacements......................................................................21

Ajuster l’alignement des formules..............................................................................................23
Alignement de la formule en cours........................................................................................23

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr



Alignement par défaut des formules......................................................................................23
Modifier la couleur dans une formule.........................................................................................24

La couleur des caractères.....................................................................................................24
La couleur d’arrière-plan.......................................................................................................24

Bibliothèque de formules..................................................................................................24

Avec Math..................................................................................................................................24
Avec Writer, Calc, Draw ou Impress...........................................................................................25
Utiliser votre bibliothèque de formules.......................................................................................25

Les formules dans Writer..................................................................................................26

Numérotation automatique des formules...................................................................................26
Numérotation.........................................................................................................................26
Renvoi...................................................................................................................................27

Ancrage des formules................................................................................................................27
Alignement vertical....................................................................................................................28
Espacement des objets..............................................................................................................29
Le mode texte............................................................................................................................30
Arrière-plan et bordures.............................................................................................................30

Arrière-plans..........................................................................................................................30
Bordures...............................................................................................................................31

Insertion rapide de formules......................................................................................................32

Les formules dans Calc, Draw et Impress.......................................................................32

Ancrage des formules................................................................................................................33
Dans Calc.............................................................................................................................33
Dans Draw et Impress...........................................................................................................33

Propriétés des objets formules...................................................................................................33
Des formules dans les diagrammes...........................................................................................33

Personnalisation................................................................................................................34

Formules chimiques...................................................................................................................34
Boîtes de dialogues flottantes....................................................................................................34
Ajouter des raccourcis clavier....................................................................................................35
Personnaliser le catalogue.........................................................................................................35

Ajouter de symboles..............................................................................................................35
Modifier le nom des symboles...............................................................................................37
Déplacer des symboles.........................................................................................................38
Supprimer des symboles.......................................................................................................38
Options d’édition des symboles.............................................................................................38

Espacement dans les formules..................................................................................................39
Extensions.................................................................................................................................40

Exportation et importation................................................................................................40

Le format MathML......................................................................................................................40
Les formats de fichier Microsoft.................................................................................................40

[C] Charger et convertir l’objet...............................................................................................41
[E] Convertir et enregistrer l’objet..........................................................................................41

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr



Introduction

LibreOffice Math est un éditeur de formule qui vous permet de créer ou de modifier des formules 
(équations) sous une forme symbolique à l’intérieur des documents de LibreOffice ou comme ob-
jets indépendants. Des exemples de formules sont proposés ci-dessous. Cependant, si vous dési-
rez calculer des valeurs numériques à partir de formules, reportez-vous au Guide Calc pour plus 
d’informations, car Math n’effectue aucun calcul.

df (x)
dx

=ln (x)+tan−1(x2)  ou NH3+H2 O→NH4
++OH−

Dans Math, l’éditeur de formule utilise un langage de balisage pour représenter les formules. Ce 
langage est conçu pour être aussi facile à lire que possible ; par exemple a over b donne la frac-

tion 
a
b

 dans une formule.

Premiers pas

Grâce à l’éditeur de formule, vous pouvez créer une formule sous forme de document indépendant
(ou fichier de bibliothèque de formules) ou insérer directement les formules dans un document 
créé avec LibreOffice Writer, Calc, Impress ou Draw.

Les formules dans les documents de LibreOffice

Pour insérer une formule dans un document de LibreOffice, ouvrez ce document dans Writer, Calc,
Draw ou Impress. La façon dont vous allez positionner le curseur pour insérer la formule dépend 
du module de LibreOffice ouvert.

• Dans Writer, cliquez dans le paragraphe où vous désirez insérer la formule.

• Dans Calc, cliquez dans la cellule où vous désirez insérer la formule.

• Dans Draw et Impress, la formule est insérée au centre du dessin ou de la diapositive.

Sélectionnez ensuite Insertion > Objet > Formule dans la barre de menu pour ouvrir l’éditeur de 
formule. Vous pouvez aussi sélectionner Insertion > Objet > Objet OLE dans la barre de menu 
pour ouvrir la boîte de dialogue Insérer un objet OLE, sélectionner l’option Créer un nouvel objet 
puis Formule dans la liste des types d’objets. Cliquez ensuite sur OK pour ouvrir l’éditeur de for-
mule. Le Volet des éléments, à gauche de la Fenêtre d’aperçu peut aussi apparaître, s’il a été co-
ché dans Affichage dans la barre de menu. Pour plus d’information sur la création de formules, 
voir « Créer des formules » page 3.

La Figure 1 montre un exemple de document Writer avec la boîte de formule sélectionnée pendant
la saisie de cette formule. À mesure que vous saisissez les éléments du langage de balisage dans 
l’éditeur de formule, cette formule apparaît dans la zone réservée au document Writer pendant et 
après la saisie.

Quand vous avez fini de saisir le code de balisage de la formule, refermez l’éditeur de formule en 
appuyant sur la touche Échap ou en cliquant hors de la formule dans le document. Un double-clic 
sur l’objet formule dans le document ouvrira de nouveau l’éditeur de formule où vous pourrez la 
modifier.

Premiers pas | 1



Les formules sont insérées dans les documents comme objets OLE. Comme pour tous ces objets, 
vous pouvez modifier l’emplacement de celui-ci dans le document. Pour plus d’informations sur les
objets OLE, voyez « Les formules dans Writer », page 26, et « Les formules dans Calc, Draw 
et Impress », page 32 ainsi que les guides de l’utilisateur de Math, Writer, Calc, Draw et Impress.

Si vous insérez souvent des formules dans des documents, il est recommandé d’ajouter le bouton 
Formule  à la barre d’outils Standard ou de créer un raccourci au clavier. Voyez « Personnali-
sation », page 34 pour plus d’informations.

Fenêtre du document Writer

Éditeur de formuleVolet des éléments

Boîte de formule

Liste des catégories

Figure 1 : Formule dans un document Writer

Conseil

Si l’aperçu est trop petit ou trop gros, vous pouvez modifier simplement le zoom en mainte-
nant la touche Ctrl enfoncée et en faisant tourner la molette de la souris ou en faisant glis-
ser la barre de zoom en bas à droite de la fenêtre.

Les formules en tant que documents indépendants

Pour créer une formule en tant que document indépendant, utilisez une des méthodes suivantes 
pour ouvrir un document vide dans LibreOffice Math :

• dans la barre de menu, sélectionnez Fichier > Nouveau > Formule ;

• depuis le centre de démarrage, cliquez sur Formule Math ;
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• dans la barre d’outils Standard, cliquez sur le triangle à droite de l’icône Nouveau et choisis-
sez Formule dans le menu déroulant ;

• dans LibreOffice Math, utilisez les touches de raccourci Ctrl+N.

La fenêtre qui s’ouvre alors est identique à la Figure 1 sauf que la fenêtre du document Writer est 
remplacée par une fenêtre où vous pouvez voir l’aspect de la formule en cours de composition.

Fenêtre d’aperçu

Éditeur de formuleVolet des éléments

Liste des catégories

Figure 2 : la fenêtre de LibreOffice Math

Comme pour l’édition de formules dans les modules Writer, Calc, Draw et Impress, le volet des 
éléments peut aussi apparaître à gauche de la zone d’aperçu, s’il a été coché dans le sous-menu 
Affichage dans la barre de menu. Pour plus d’information sur la création de formules, voyez 
« Créer des formules » ci-dessous.

Créer des formules

Vous pouvez insérer une formule en utilisant une des méthodes suivantes :

• dans le volet des éléments, choisissez une catégorie dans la liste déroulante puis un sym-
bole dans le Volet des éléments ;

• faites un clic droit dans l’éditeur de formule et choisissez une catégorie puis un symbole 
dans le menu contextuel ;

• saisissez directement le langage de balisage dans l’éditeur de formule.
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Remarque

L’utilisation du volet des éléments ou des menus contextuels pour créer une formule offre un
moyen pratique et efficace pour apprendre le langage de balisage utilisé par Math.

Conseil

Si vous utilisez le volet des éléments, il est conseillé de cocher l’option Infoballons dans la 
section Aide de la page LibreOffice – Général de la boîte de dialogue Options (Outils > Op-
tions dans la barre de menu) pour vous aider à identifier les catégories et les symboles que 
vous voulez utiliser dans votre formule.

Le volet des éléments

Le volet des éléments peut servir à saisir facilement les données d’une formule. En plus des caté-
gories de la liste en haut de la fenêtre, il offre aussi une catégorie Exemples qui peuvent servir de 
points de départ de formules ou d’équations.

 1) Sélectionnez Affichage dans la barre de menu et cochez Éléments pour ouvrir le Volet des 
éléments (Figure 3) s’il n’est pas visible.

 2) Choisissez la catégorie souhaitée dans la liste déroulante en haut du volet des éléments.

 3) Choisissez le symbole que vous désirez utiliser dans votre formule dans le volet des élé-
ments. Les symboles disponibles dépendent de la catégorie choisie.

Figure 3 : Le volet des éléments

Remarque

Le volet des éléments est soit une boîte de dialogue flottante, soit positionné à gauche de 
l’éditeur de formule comme on le voit sur la Figure 1 et la Figure 2.

Le menu contextuel

L’éditeur de formule propose aussi un menu contextuel qui permet d’accéder aux catégories et 
symboles nécessaires à la création d’une formule. Un clic droit dans l’éditeur de formule ouvre ce 
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menu. Choisissez une catégorie puis un exemple de code de balisage que vous désirez utiliser 
dans le sous-menu comme le montre la Figure 4.

Remarque

Le volet des éléments et le menu contextuel ne proposent que les commandes les plus cou-
ramment utilisées dans les formules. Pour les commandes d’utilisation plus rare, vous devez
toujours les saisir en utilisant le langage de balisage. Pour une liste complète des com-
mandes, voyez l’Annexe A, Référence des commandes, du Guide Math.

Figure 4 : Le menu contextuel de l’éditeur de formule

Le langage de balisage

Le langage de balisage est saisi directement dans l’éditeur de formule. Par exemple, taper 
5 times 4 dans l’éditeur de formule crée la formule 5×4 . Avec de l’expérience, cela peut deve-
nir le moyen le plus rapide pour saisir une formule. Le Tableau 1 montre quelques exemples d’utili-
sation du langage de balisage pour saisir des commandes. Pour une liste complète des com-
mandes utilisables dans l’éditeur d’équation, voyez l’Annexe A, Référence des commandes, du 
Guide Math.

Tableau 1 : Exemples de commande qui utilisent le langage de balisage

Affichage Commande Affichage Commande

a=b a = b √a sqrt {a}

a2 a^2 an a_n

∫ f (x)dx int f(x) dx ∑ an sum a_n

a≤b a <= b ∞ infinity

a×b a times b x⋅y x cdot y
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Lettres grecques

Avec le langage de balisage

Les lettres grecques sont couramment utilisées dans les équations, mais on ne peut pas les saisir 
avec le volet des éléments ni le menu contextuel. Utilisez les noms dans la langue de l’interface 
(en français, attention aux accents) des lettres grecques dans le langage de balisage pour les faire
entrer dans une formule. Voyez à l’annexe A, Référence des Commandes du guide Math une liste 
des caractères grecs qui peuvent être saisis dans le langage de balisage.

• Pour une lettre grecque minuscule, tapez le symbole pourcent (%) suivi du nom français du 
caractère en minuscules. Par exemple, taper %lambda crée la lettre grecque λ.

• Pour une lettre grecque MAJUSCULE, tapez le symbole pourcent (%) suivi du nom français 
du caractère en MAJUSCULES. Par exemple, taper %LAMBDA crée la lettre grecque Λ.

• Pour une lettre grecque en italique, tapez le symbole pourcent (%) suivi du caractère i puis 
du nom français du caractère grec en minuscules ou en MAJUSCULES. Par exemple, taper 
%iTHÊTA crée la lettre grecque italique Θ.

La boîte de dialogue Symboles

Les lettres grecques peuvent aussi être saisies dans une formule avec la boîte de dialogue Sym-
boles.

 1) Vérifiez que le curseur est dans la position voulue dans l’éditeur de formule.

 2) Sélectionnez Outils > Symboles dans la barre de menu ou cliquez sur l’icône Symboles 
dans la barre d’outils pour ouvrir la boîte de dialogue Symboles (Figure 5).

 3) Sélectionnez Grec dans la liste déroulante Jeu de symboles. Pour des caractères italiques, 
sélectionnez iGrec dans cette même liste déroulante.

 4) Sélectionnez le caractère grec dans la liste des symboles puis cliquez sur Insérer. Quand un
caractère est sélectionné, son nom est indiqué sous la liste des symboles.

 5) Cliquez sur Fermer quand vous avez fini de saisir les lettres grecques dans votre formule.

Figure 5: La boîte de dialogue Symboles
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Unicode des caractères grecs

Si votre document peut être ouvert dans une version du logiciel avec une interface de langue diffé-
rente, les balises de la forme%nom_de_la_lettre_dans_la_langue_de_l’interface peuvent poser 
problème. Si vous pensez que cela peut se produire, il est alors conseillé d’utiliser les caractères 
unicode des lettres grecques en utilisant une des deux méthodes suivantes :

• insérez la lettre dans Writer, soit par la commande Insérer > Caractères spéciaux, soit par 
l’autocorrection __lettre. Par exemple, __a sera transformé en α. Copiez la lettre puis col-
lez-la dans Math

• dans l’éditeur de formule, tapez le code hexadécimal de l’unicode de la lettre, par exemple 
3B1 pour α, puis tapez Alt+X

L’avantage de la première méthode est qu’elle ne nécessite pas de connaître l’unicode de la lettre. 
L’avantage de la seconde méthode est qu’elle est plus directe.

Exemples de formules

Exemple 1

La formule simple 5×4  peut être créée avec LibreOffice Math comme ceci :

 1) Vérifiez que le curseur clignote dans l’éditeur de formule puis sélectionnez la catégorie Opé-
rateurs unaires/binaires et le symbole de la multiplication par l’une des méthodes sui-
vantes :

– dans le volet des éléments, sélectionnez Opérateurs unaires/binaires dans la liste dé-
roulante puis l’icône de la multiplication  ;

– faites un clic droit dans l’éditeur de formule puis sélectionnez Opérateurs Unaires/Bi-
naires > a times b dans le menu contextuel.

 2) Ces deux méthodes placent le texte <?> times <?> dans l’éditeur de formule et  ap-
paraît dans le document.

 3) Si ce n’est déjà fait, sélectionnez le premier paramètre fictif <?> avant le mot times dans 
l’éditeur de formule en appuyant sur F4 et remplacez-le par le chiffre 5. La formule se met 
automatiquement à jour dans votre document.

 4) Sélectionnez le deuxième paramètre fictif <?> après le mot times dans l’éditeur de formule 
en appuyant sur F4 et remplacez-le par le chiffre 4. La formule se met automatiquement à 
jour dans votre document.

Avec le langage de balisage, vous pouvez saisir directement 5 times 4 dans l’éditeur de for-
mule. Math place la formule 5×4  directement dans votre document

Conseil

Pour avancer d’un paramètre fictif <?> au suivant dans une formule, appuyez sur la touche 
F4. Pour reculer d’un paramètre fictif au précédent, utilisez la combinaison Maj+F4.
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Remarque

Si nécessaire, vous pouvez éviter qu’une formule soit mise automatiquement à jour dans un 
document. Sélectionnez Affichage dans la barre de menu et décochez Rafraîchir automa-
tiquement l’affichage. Pour mettre à jour manuellement une formule, appuyez sur la 
touche F9 ou sélectionnez Affichage > Actualiser dans la barre de menu.

Exemple 2

Vous désirez saisir la formule π ≃ 3 ,14159  où la valeur de pi est arrondie à 5 décimales. Vous 
connaissez le nom de la lettre grecque (pi) mais pas la balise associée au symbole Est 
similaire ou égal ≃ .

 1) Vérifiez que le curseur clignote dans l’éditeur de formule.

 2) Saisissez %pi dans l’éditeur de formule pour entrer la lettre grecque pour pi (π).

 3) Sélectionnez la catégorie Relations et le symbole Est similaire ou égal par l’une des mé-
thodes suivantes ;

– dans le volet des éléments, sélectionnez Relations dans la liste déroulante puis l’icône 
Est similaire ou égal  ;

– faites un clic droit dans l’éditeur de formule et sélectionnez Relations > a simeq b dans le
menu contextuel.

 4) Effacez le premier paramètre fictif <?> avant le mot simeq dans l’éditeur de formule.

 5) Sélectionnez le deuxième paramètre fictif <?> après le mot simeq dans l’éditeur de formule 
en appuyant sur F4 et remplacez-le par les caractères 3,14159. La formule π ≃ 3,14159  
apparaît alors dans votre document.

Éditer les formules

La façon dont on édite une formule et dont on passe en mode d’édition dépend de l’endroit où elle 
se trouve, dans Math ou dans un autre module de LibreOffice.

 1) Dans Math, faites un double-clic sur un élément de la formule qui apparaît dans la fenêtre 
d’aperçu pour le sélectionner dans l’éditeur de formule ou sélectionnez-le directement dans 
l’éditeur de formule.

 2) Dans Writer, Calc, Impress ou Draw, faites un double-clic sur la formule ou un clic droit sur 
celle-ci et sélectionner Éditer dans le menu contextuel pour ouvrir l’éditeur de formule et 
passer en mode d’édition. Le curseur est placé au début de la formule dans l’éditeur de for-
mule.

Remarque

Si vous ne pouvez pas sélectionner un élément de formule avec votre curseur, cliquez sur 
l’icône Curseur de formule  dans la barre d’outils pour activer le curseur de formule.

 3) Sélectionnez l’élément de formule que vous désirez modifier avec l’une des méthodes sui-
vantes :
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– cliquez sur l’élément de formule dans la fenêtre d’aperçu pour positionner le curseur au 
début de l’élément de formule puis sélectionnez-le dans l’éditeur de formule,

– faites un double-clic sur l’élément de formule dans la fenêtre d’aperçu pour le sélectionner
dans l’éditeur de formule,

– positionnez le curseur dans l’éditeur de formule sur l’élément de formule que vous voulez 
éditer puis sélectionnez-le,

– faites directement un double-clic sur l’élément de formule dans l’éditeur de formule pour le
sélectionner.

 4) Effectuez vos modifications sur l’élément de formule que vous avez sélectionné.

 5) Sélectionnez Affichage > Actualiser dans la barre de menu, appuyez sur la touche F9 ou 
cliquez sur l’icône Actualiser  dans la barre d’outils pour mettre à jour si nécessaire la for-
mule dans la fenêtre d’aperçu ou votre document.

 6) Dans Math, enregistrez vos modifications de la formule après édition.

Dans Writer, Calc, Impress ou Draw, cliquez n’importe où hors de la formule dans votre do-
cument pour quitter le mode d’édition puis enregistrer votre document pour sauvegarder les 
modifications de la formule.

Agencement des formules

Cette section offre quelques conseils sur la façon d’agencer des formules complexes dans Math 
ou dans votre document LibreOffice.

Utilisation des accolages

Math ne sait rien de l’ordre des opérations dans une formule. Vous devez utiliser des accolades 
pour indiquer l’ordre des opérations à l’intérieur d’une formule. Les exemples suivants montrent 
comment utiliser des accolades dans une formule.

Exemple 1

2 over x + 1 donne le résultat 
2
x
+1

Math a reconnu que le 2 avant et le x après le over appartiennent à la fraction et les a re-
présentés en conséquence. Si vous voulez que le dénominateur soit x+1 au lieu de x, vous 
devez le placer entre accolades.

Mettre des accolades dans 2 over {x + 1} donne le résultat 
2
x+1

 où x+1 est mainte-

nant au dénominateur.

Exemple 2

– 1 over 2 donne le résultat 
−1
2

Math a reconnu le signe moins comme préfixe du 1 et l’a donc placé au numérateur de la 
fraction. Si vous désirez montrer que la fraction est négative, avec le signe moins devant 
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elle, vous devez mettre celle-ci entre accolades pour indiquer à Math que ce signe s’applique
à l’ensemble.

Ajouter des accolades dans le langage de balisage – {1 over 2} donne le résultat –
1
2
 

et la fraction est maintenant négative.

Exemple 3

Quand les accolades sont utilisées dans le langage de balisage, elles servent à définir 
l’agencement de la formule et ne sont ni affichées ni imprimées. Si vous voulez faire appa-
raître des accolages à l’intérieur d’une formule, utilisez les commandes lbrace et rbrace 
dans le langage de balisage.

x over {–x + 1} donne le résultat 
x

– x+1

Remplacez les accolades en utilisant les commandes lbrace et rbrace dans le langage 

de balisage. Écrivez x over lbrace –x + 1 rbrace et le résultat est 
x

{– x+1}

Parenthèses et matrices

Si vous voulez utiliser une matrice dans une formule, vous devez utiliser la commande matrix. 

Par exemple, matrix { a # b ## c # d } donne comme résultat la matrice 
a b
c d

 dans 

votre formule. Les lignes sont séparées par deux dièses (##) et les entrées dans chaque ligne par 
un seul dièse (#).

Normalement, quand vous utilisez des parenthèses dans une matrice, celles-ci ne s’adaptent pas 
quand la taille de la matrice augmente. Par exemple, ( matrix { a # b ## c # d } ) 

donne le résultat (a b
c d

) .

Pour résoudre ce problème de parenthésage d’une matrice, Math propose des parenthèses va-
riables dont la taille augmente avec celle de la matrice. Les commandes left( et right) doivent
être utilisées pour créer des parenthèses ajustables dans une matrice. Par exemple, 

left( matrix { a # b ## c # d } right) donne le résultat (a b
c d)  où la matrice est 

maintenant entourée de parenthèses variables.

Les parenthèses variables peuvent aussi être utilisées avec n’importe quel élément de formule, 
comme les fractions, les racines carrées et ainsi de suite.

Conseil

Utilisez les commandes left[ et right] pour obtenir des crochets de taille adaptable. 
Une liste de toutes les parenthèses disponibles dans Math est située dans l’Annexe A, Réfé-
rence des Commandes, du Guide Math.
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Astuce

Si vous désirez que toutes les parenthèses aient une taille variable, sélectionnez Format > 
Espacement dans la barre de menu pour ouvrir la boîte de dialogue Espacement. Cliquez 
sur Catégorie, sélectionnez Accolades dans la liste déroulante puis cochez l’option Ajuster 
toutes les parenthèses.

Parenthèses non appariées

Quand on utilise des parenthèses dans une formule, Math attend que, pour chaque parenthèse ou-
vrante, il en existe une fermante. Si vous oubliez d’ajouter une parenthèse fermante, Math place 
un point d’interrogation à l’envers près de l’endroit où celle-ci devrait se trouver. Celui-ci disparaît 
quand toutes les parenthèses sont appariées. Une parenthèse non appariée est cependant parfois
nécessaire et vous avez les options suivantes.

Parenthèses de taille fixe

Une barre oblique inversée \ est placée avant une parenthèse de taille fixe pour indiquer que le 
caractère qui la suit ne doit pas être considéré comme une parenthèse mais comme un caractère 
ordinaire.

Par exemple, les crochets sont délibérément non appariés dans la formule [ a ; b [, mais 
donne le résultat ¿ . Pour supprimer le point d’interrogation renversé et créer des crochets non ap-
pariés, des barres obliques inversées sont ajoutées. La formule devient alors \ [ a ; b \ [ et 
le résultat [a;b [  affiche des crochets non appariés sans point d’interrogation renversés.

Parenthèses de taille variable

Pour créer des parenthèses ou des accolades de taille variable non appariées, on utilise les com-
mandes de balisage left, right et none.

Exemple

Vous voulez créer la formule |x|={ x pour x≥0
−x pour x<0

 et vous saisissez abs x = lbrace 

stack {x "pour" x >= 0 # -x "pour" x < 0} dans l’éditeur de formule.

Mais vous obtenez ce résultat incorrect |x|=¿  .

Pour faire disparaître le point d’interrogation renversé et créer une formule correcte, vous de-
vez utiliser les commandes de balisage left, right et none. Modifiez votre saisie dans 
l’éditeur d’équation pour abs x = left lbrace stack {x "pour" x >= 0 # -x 
"pour" x < 0} right none et cela vous donne la formule correcte.

Reconnaissance des fonctions

Dans l’installation par défaut de Math, celui-ci produit des fonctions en caractères normaux et des 
variables en italique. Mais si Math n’arrive pas à reconnaître une fonction, vous pouvez lui dire que
vous venez d’en saisir une. Saisir la commande de balisage func avant une fonction oblige Math 
à reconnaître le texte suivant comme une fonction et à utiliser des caractères normaux.

Pour une liste complète des fonctions dans Math, voyez l’Annexe A, Référence des Commandes 
du Guide Math.
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Certaines fonctions de Math doivent être suivies d’un nombre ou d’une variable. Si ceux-ci sont ab-
sents, Math place un point d’interrogation renversé où ils devraient se trouver. Pour le faire dispa-
raître et corriger la formule, vous devez saisir un nombre, une variable ou une paire d’accolades 
vide {} comme paramètre fictif.

Conseil

Vous pouvez passer d’une erreur à l’autre dans une formule grâce à la touche F3 (erreur 
suivante) et à la combinaison de touches Maj+F3 (erreur précédente).

Formules sur plusieurs lignes

Supposons que vous vouliez créer une formule qui demande plusieurs lignes, par exemple x=3
y=1

. 

Votre première réaction serait normalement d’appuyer sur la touche Entrée. Si vous le faites, le 
langage de balisage passe bien à la ligne dans l’éditeur de formule mais la formule produite n’a 
pas deux lignes. Vous devez taper la macro-commande newline à chaque fois que vous voulez 
créer et afficher une nouvelle ligne dans une formule.

Exemple

x = 3
y = 1
donne le résultat incorrect x=3 y=1

x = 3 newline y = 1 donne le résultat correct x=3
y=1

On ne peut pas créer dans Math de formules de plusieurs lignes quand l’une d’elles se termine par
un signe égal et que l’on veut continuer le calcul sur une nouvelle ligne sans indiquer le membre 
de droite du signe égal. Si vous devez le faire, utilisez soit des guillemets vides "", soit des acco-
lades vides {}, soit les caractères d’espacement accent grave ` ou tilde ~.

Par défaut, l’alignement des formules sur plusieurs lignes est centré. Pour plus d’information sur 
l’alignement sur le signe égal, voir ci-dessous « Aligner les formules sur le signe égal » page
15.

L’espace entre les éléments d’une formule n’est pas défini par l’utilisation de caractères espace 
dans le langage de balisage. Si vous voulez ajouter des espaces dans votre formule, utilisez une 
des options suivantes :

• un accent grave ` pour ajouter un petit espace ;

• un tilde ~ pour un grand espace ;

• ajouter des caractères espace entre guillemets " ". Ils seront considérés comme du texte.

Tout espace à la fin d’une ligne de langage de balisage est ignoré par défaut. Pour plus d’informa-
tion, voir « Espacement dans les formules », page 39.

Ajout de limites aux commandes somme et intégrale

Les commandes sum, prod et int permettent de créer des formules avec des sommes, des pro-
duits et des intégrales respectivement. Elles peuvent facultativement recevoir les paramètres from
et to si vous voulez définir les limites respectivement inférieure et supérieure, comme on le voit 
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sur les exemples suivants. Pour plus d’informations sur les commandes somme, produit et inté-
grale, voyez l’Annexe A, Référence des commandes, du Guide Math.

Exemples

sum from k = 1 to n a_k donne le résultat ∑
k=1

n

ak

int from 0 to x f(t) dt donne le résultat ∫
0

x

f (t)dt

int_0^x f(t) dt donne le résultat ∫0

x

f ( t)dt

int from Re f donne le résultat ∫
ℜ

f

sum to infinity 2^{-n} donne le résultat ∑
∞

2−n

prod from {n=1} to {infinity} left({4n²} over {4n^2 - 1} right) 

donne le résultat ∏
n=1

∞ ( 4 n2

4 n2−1)
Écriture des dérivées

Pour écrire une dérivée, vous devez indiquer à Math que c’est une fraction en utilisant la com-
mande over. Celle-ci est combinée avec le caractère d pour une dérivée totale ou la commande 
partial pour une dérivée partielle pour obtenir l’effet désiré. Des accolades {} entourent l’élé-
ment et font apparaître les dérivées comme on le voit dans les exemples suivants.

Exemples

{df} over {dx} donne le résultat 
df
dx

{partial f} over {partial y} donne le résultat 
∂ f
∂ y

{partial^2 f} over {partial t^2} donne le résultat 
∂2 f

∂ t2

Remarque

Pour écrire les noms de fonctions avec un prime, comme dans la notation scolaire habi-
tuelle, vous devez d’abord ajouter le symbole au catalogue. Voyez « Ajouter de sym-
boles », page 35 pour plus d’informations.

Caractères du langage de balisage employés comme caractères 
ordinaires

Les caractères utilisés comme caractères de contrôle dans le langage de balisage ne peuvent pas 
être saisis directement comme des caractères normaux. Ce sont les caractères %, {, }, &, |, _, ^ 
et ". Pour surmonter cette limitation du langage de balisage, utilisez une des méthodes suivantes :
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• Utilisez des guillemets doubles de chaque côté du caractère pour le marquer comme texte. 
Par exemple, 2"%"= 0,02 apparaîtra comme 2%=0,02  dans votre formule. Cette mé-
thode n’est cependant pas applicable au caractère guillemet double lui-même, voyez « Du 
texte dans les formules » ci-dessous.

• Ajoutez le caractère au catalogue de Math, par exemple le caractère guillemet double.

• Utilisez des commandes, par exemple lbrace et rbrace vous donnent des caractères ac-
colades {} .

Remarque

La boîte de dialogue Caractères spéciaux utilisée par les autres modules de LibreOffice 
n’est pas disponible dans Math. Si vous avez régulièrement besoin de caractères spéciaux 
dans Math, il est recommandé de les ajouter au Catalogue. Voyez « Ajouter de sym-
boles », page 35 pour plus d’informations.

Du texte dans les formules

Pour inclure du texte dans une formule, vous devez l’entourer de guillemets doubles, par exemple 
x " pour " x >= 0 dans le langage de balisage va créer la formule x  pour x≥0 . Tous les ca-
ractères, sauf les guillemets doubles, peuvent être utilisés dans le texte. Si, cependant, vous avez 
besoin de guillemets doubles dans le texte d’une formule, vous pouvez utiliser le caractère unicode
ʺ ou ˮ en tapant 2BA ou 2EE puis Alt+X. Pour obtenir des guillemets français, le plus simple est de 
créer le texte dans Writer, de le copier puis de le coller dans l’éditeur de formule (Figure 6).

Figure 6 : Exemple de guillemets dans une formule.

La police utilisée pour le texte dans une formule est la police par défaut définie dans la boîte de 
dialogue Polices. Pour plus d’informations sur la façon de modifier les polices utilisées dans les 
formules, voyez « Modifier l’apparence d’une formule » page 15.

Par défaut, le texte est aligné à gauche dans les formules. Pour plus d’information sur la façon de 
modifier l’alignement du texte, voyez « Ajuster l’alignement des formules » page 23.

Les commandes de mise en forme ne sont pas interprétées à l’intérieur du texte utilisé dans les 
formules. Si vous voulez le faire, vous devez séparer le texte par des guillemets doubles dans 
l’éditeur de formule.
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Exemple

Saisissez le texte suivant dans l’éditeur de formule :

"Dans un triangle " color blue bold "isocèle" "les angles à la base 
sont égaux"

vous obtenez le texte suivant dans une formule :
Dans un triangle isocèle les angles à la base sont égaux  

Aligner les formules sur le signe égal

LibreOffice Math ne possède pas de commande pour aligner les formules sur un caractère particu-
lier. Cependant, vous pouvez utiliser une matrice pour aligner les formules sur un caractère qui est 
normalement le signe égal (=).

Exemple

Créer la matrice :

matrix{ alignr x+y # {}={} # alignl 2 ## alignr x   # {}={} # alignl
2-y }

donne le résultat suivant où les formules sont alignées sur le signe égal x+ y = 2
x = 2−y

Remarque

Les accolades vides de chaque côté des signes égal sont nécessaires parce que celui-ci est
un opérateur binaire qui exige une expression de part et d’autre. Vous pouvez utiliser des 
caractères espace, ` ou ~ mais les accolades sont recommandées, car elles sont plus vi-
sibles dans le langage de balisage.

Vous pouvez réduire l’espacement de chaque côté des signes égal en modifiant l’espace entre les 
colonnes de la matrice. Voyez « Ajuster l’espacement dans les formules » page 19 pour plus 
d’informations.

Modifier l’apparence d’une formule

Taille de la police d’une formule

Taille de la police de la formule en cours

Pour modifier la taille de la police utilisée dans une formule déjà insérée dans Math ou un autre 
module de LibreOffice :

 1) Cliquez dans le langage de balisage dans l’éditeur de formule.

 2) Sélectionnez Format > Taille de police dans la barre de menu pour ouvrir la boîte de dia-
logue Tailles de police (Figure 7).

 3) Choisissez une taille de police avec le sélecteur Taille de base ou tapez-la directement dans 
la boîte.
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 4) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue. Voyez ci-
dessous un exemple obtenu en modifiant la taille de la police.

Exemple

Taille de police par défaut (12 pt) : π ≃ 3,141 59

Après changement de taille de police à 18 pt : π ≃ 3,141 59

Figure 7 : La boîte de dialogue Tailles de police

Taille par défaut de la police dans les formules

Pour modifier la taille par défaut de la police utilisée par toutes les formules dans Math ou un autre 
module de LibreOffice :

 1) Avant d’insérer une formule dans votre document, sélectionnez Format > Taille de police 
dans la barre de menu pour ouvrir la boîte de dialogue Tailles de police (Figure 7).

 2) Sélectionnez une taille de police différente avec le sélecteur Taille de base ou tapez une 
nouvelle taille dans la zone de saisie.

 3) Cliquez sur Par défaut et confirmez vos changements de la taille de base de la police. Toute 
formule créée à partir de ce moment-là utilisera la nouvelle taille de base.

 4) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue.

Remarque

Si vous avez déjà inséré des formules dans votre document et que vous modifiez la taille de 
police par défaut, seules les formules insérées après la modification utiliseront le nouveau 
réglage. Vous devez modifier individuellement la taille de la police des formules déjà insé-
rées si vous voulez que celles-ci utilisent la taille par défaut que vous venez de configurer.

Conseil

Il existe une extension « Formatting of All Math Formulas » (Formatage de toutes les for-
mules de Math) qui vous permet de modifier le nom et la taille de la police utilisée par toutes
les (ou une sélection de) formules de votre document. Vous pouvez la télécharger sur le site
officiel des extensions : https://extensions.libreoffice.org/en/extensions/show/formatting-of-
all-math-formulas.
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Options de la boîte de dialogue Tailles de police

La boîte de dialogue Tailles de police (Figure 7) définit les tailles de la police utilisée pour vos for-
mules. Quand vous sélectionnez une taille de base, tous les éléments de la formule sont mis à 
l’échelle par rapport à celle-ci.

Taille de base
Tous les éléments d’une formule ont une taille proportionnelle à la taille de base. Pour modi-
fier celle-ci, sélectionnez ou saisissez la taille souhaitée en point (pt) dans le champ. Vous 
pouvez aussi utiliser d’autres unités de mesure qui sont automatiquement converties en 
points. Par exemple, si vous saisissez 1 cm, Math convertit la valeur en 28 pt.

Tailles relatives
Vous pouvez définir dans cette section la taille relative de chaque élément d’une formule par 
rapport à la taille de base.

– Texte : choisissez ici la taille relative du texte d’une formule par rapport à la taille de base ;

– Index : choisissez ici la taille relative des indices dans une formule par rapport à la taille 
de base ;

– Fonctions : choisissez ici la taille relative des noms et autres éléments des fonctions dans 
une formule par rapport à la taille de base ;

– Opérateurs : choisissez ici la taille relative des opérateurs mathématiques dans une for-
mule par rapport à la taille de base ;

– Limites : choisissez ici la taille relative des limites dans une formule par rapport à la taille 
de base.

Par défaut
Cliquer sur ce bouton pour enregistrer les modifications comme valeurs par défaut pour 
toutes les nouvelles formules. Un message vous demande confirmation avant d’enregistrer 
ces modifications.

Polices des formules

Polices de la formule en cours

Pour modifier les polices utilisées par la formule en cours dans Math ou un autre module de 
LibreOffice :

 1) Cliquez dans le langage de balisage dans l’éditeur de formule.

 2) Sélectionnez Format > Polices dans la barre de menu pour ouvrir la boîte de dialogue Po-
lices (Figure 8).

 3) Sélectionnez une nouvelle police pour chaque option dans les listes déroulantes.

 4) Si la police que vous désirez utiliser n’apparaît pas dans la liste déroulante, cliquez sur Mo-
difier et sélectionnez l’option dans le menu contextuel pour ouvrir la boîte de dialogue de po-
lices. Choisissez-y la police que vous voulez utiliser et cliquez sur OK pour l’ajouter à la liste 
déroulante de cette option.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Polices.
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Figure 8 : La boîte de dialogue Polices

Polices par défaut des formules

Pour changer les polices par défaut utilisées par toutes les nouvelles formules dans Math et les 
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans votre document, sélectionnez Format > Polices dans la 
barre de menu pour ouvrir la boîte de dialogue Polices (Figure 8).

 2) Sélectionnez une nouvelle police pour chaque option dans les listes déroulantes.

 3) Si la police que vous désirez utiliser n’apparaît pas dans la liste déroulante, cliquez sur Mo-
difier et sélectionnez l’option dans le menu contextuel pour ouvrir la boîte de dialogue de po-
lices. Choisissez-y la police que vous voulez utiliser et cliquez sur OK pour l’ajouter à la liste 
déroulante de cette option.

 4) Cliquez sur Par défaut et confirmez vos modifications des polices. Toutes les formules 
créées à partir de ce point utiliseront les nouvelles polices.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Polices.

Remarque

Si vous avez déjà inséré des formules dans votre document et que vous modifiez les polices
par défaut, seules les formules insérées après la modification utiliseront le nouveau réglage.
Vous devez modifier individuellement les polices des formules déjà insérées si vous voulez 
que celles-ci utilisent les polices par défaut que vous venez de configurer.

Options de la boîte de dialogue Polices

Elles vous permettent de définir les polices qui pourront être appliquées aux éléments d’une for-
mule.

Polices des formules
Choisissez ici les polices utilisées pour les variables, les fonctions, les nombres et le texte in-
séré qui constituent les éléments d’une formule.

– Variables : choisissez les polices pour les variables de votre formule. Par exemple, dans 
la formule x=SIN(y), x et y sont des variables utiliseront la police affectée ici ;
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– Fonctions : choisissez les polices pour les noms et propriétés des fonctions. Par exemple,
dans la formule x=SIN(y), la fonction est SIN( ) ;

– Nombres : choisissez les polices pour les nombres de votre formule ;

– Texte : choisissez les polices pour le texte de votre formule.

Polices personnalisées
Dans cette section de la boîte de dialogue Polices (Figure 8, page 18), sont définies les po-
lices qui formatent les autres composants textuels d’une formule. Les trois polices de base 
Serif, Sans-serif et Largeur fixe sont disponibles. D’autres polices peuvent être ajoutées à 
chaque police standard de base grâce au bouton Modifier. Toutes les polices installées sur 
un ordinateur peuvent être utilisées.

– Serif : définissez ici la police utilisée pour le format de police à empattements. Les empat-
tements sont de petits « guides visuels » visibles, par exemple, en bas des jambages du 
A majuscule quand la police Liberation Serif est utilisée. Leur but est de guider l’œil du 
lecteur en ligne droite pour faciliter et accélérer la lecture ;

– Sans-serif : définissez ici la police utilisée pour le format de police sans empattement ;

– Largeur fixe : définissez ici la police utilisée pour le format de police à largeur fixe.

Modifier
Cliquez sur une des options du menu contextuel pour accéder à une autre boîte de dialogue 
Polices où vous pourrez choisir la police et ses attributs pour les éléments de formule et les 
polices personnalisées.

Par défaut
Cliquer sur ce bouton pour enregistrer les modifications comme valeurs par défaut pour 
toutes les nouvelles formules. Un message vous demande confirmation avant d’enregistrer 
ces modifications.

Remarque

Quand une nouvelle police est choisie pour une formule, la précédente reste accessible 
dans la liste déroulante où elle peut être de nouveau sélectionnée.

Remarque

Les variables devraient être écrites en italique, aussi assurez-vous que l’option Italique a 
bien été cochée. Pour tous les autres éléments, utilisez la forme de base de la police. Le 
style peut facilement être modifié dans la formule elle-même en utilisant les commandes 
italic ou bold, pour définir les attributs italique et gras, et nitalic ou nbold, pour arrê-
ter leur emploi.

Ajuster l’espacement dans les formules

Utilisez la boîte de dialogue Espacement (Figure 9) pour déterminer l’espacement entre les élé-
ments d’une formule. L’espacement est donné en pourcentage de la taille de base définie pour les 
polices.
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Espacement de la formule en cours

Pour modifier l’espacement utilisé par la formule courante dans Math et les autres modules de 
LibreOffice :

 1) Cliquez dans l’éditeur de formule.

 2) Sélectionnez Format > Espacement dans la barre de menu pour ouvrir la boîte de dialogue 
Espacement (Figure 9).

Figure 9 : La boîte de dialogue Espacement

 3) Cliquez sur Catégorie et choisissez une des options dans la liste déroulante. Les choix dans
la boîte de dialogue Espacement changent en fonction de la catégorie sélectionnée.

 4) Saisissez les nouvelles valeurs d’espacement pour cette catégorie et cliquez sur OK.

 5) Vérifiez le résultat dans votre formule. S’il ne vous donne pas satisfaction, répéter les étapes
précédentes.

Espacement par défaut des formules

Pour modifier l’espacement par défaut utilisé par toutes les nouvelles formules dans Math et les 
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans un document, sélectionnez Format > Espacement sur la 
barre de menu pour ouvrir la boîte de dialogue Espacement (Figure 9).

 2) Cliquez sur Catégorie et choisissez une des options dans la liste déroulante. Les choix dans
la boîte de dialogue Espacement changent en fonction de la catégorie sélectionnée.

 3) Saisissez les nouvelles valeurs d’espacement pour cette catégorie.

 4) Cliquez sur Par défaut et confirmez les modifications des espacements dans les formules. 
Toute formule créée à partir de ce moment utilisera les nouveaux espacements.

 5) Cliquez sur OK pour enregistrer vos changements et fermer la boîte de dialogue Espace-
ment.

Remarque

Si vous avez déjà inséré des formules dans votre document et que vous modifiez les espa-
cements par défaut, seules les formules insérées après la modification utiliseront le nouveau
réglage. Vous devez modifier individuellement les espacements des formules déjà insérées 
si vous voulez que celles-ci utilisent les espacements par défaut que vous venez de configu-
rer.
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Options de la boîte de dialogue Espacements

Utilisez le bouton Catégorie de la boîte de dialogue Espacement (Figure 9) pour déterminer l’élé-
ment dont vous désirez définir l’espacement. L’apparence de la boîte de dialogue dépend de la ca-
tégorie choisie. Une zone d’aperçu vous montre quel espacement est modifié grâce aux champs 
disponibles.

Catégorie
Cliquez sur ce bouton pour sélectionner la catégorie dont vous allez modifier les espace-
ments.

Espacement
Définissez ici l’espacement entre les variables et les opérateurs, entre les lignes et entre la 
barre horizontale du symbole de racine carrée et le radical.

– Espacement définit l’espacement entre les variables et les opérateurs ;

– Interligne définit l’espacement entre les lignes ;

– Espacement de la racine définit l’espacement entre la barre horizontale du symbole de ra-
cine carrée et le radical.

Index
Définissez ici l’espacement des indices et des exposants.

– Exposant définit l’espacement des exposants ;

– Indice définit l’espacement des indices.

Fractions
Définissez ici l’espacement entre la barre de fraction et le numérateur ou le dénominateur.

– Numérateur définit l’espacement entre la barre de fraction et le numérateur ;

– Dénominateur définit l’espacement entre la barre de fraction et le dénominateur.

Barres de fraction
Définissez ici la longueur dont la barre de fraction dépasse de part et d’autre du numérateur 
et du dénominateur, ainsi que son épaisseur.

– Dépassement de longueur définit la longueur dont la barre de fraction dépasse du numé-
rateur et du dénominateur ;

– Graisse définit l’épaisseur de la barre de fraction.

Limites
Définissez ici l’espacement entre le symbole de sommation (Σ) et les conditions limites.

– Limite supérieure définit l’espacement entre le haut du symbole de sommation et la limite 
supérieure ;

– Limite inférieure définit l’espacement entre le bas du symbole de sommation et la limite in-
férieure.

Accolades
Définissez ici l’espacement entre les parenthèses, crochets et accolades et leur contenu. 

– Dépassement de taille (droite/gauche) définit la distance verticale entre le bord supérieur 
du contenu et la limite supérieure des parenthèses ;
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– Espacement définit la distance horizontale entre le contenu et la limite supérieure des pa-
renthèses ;

– Ajuster toutes les parenthèses permet d’ajuster les dimensions de tous les types de pa-
renthèses. Si vous saisissez ( a over b ) dans l’éditeur de formule quand cette option
est cochée, les parenthèses entoureront la fraction sur toute sa hauteur. Si elle n’est pas 
cochée, vous obtenez normalement ce résultat en saisissant left ( a over b right
).

– Dépassement de taille définit le pourcentage de dépassement de taille. S’il vaut 0 %, les 
parenthèses ont la même hauteur que les arguments qu’ils encadrent. Plus le pourcen-
tage est élevé, plus l’espacement vertical entre le contenu des parenthèses et leur limite 
externe est grand. Ce champ n’est accessible que si l’option Ajuster toutes les paren-
thèses est cochée.

Matrice
Définissez ici les espacements relatifs entre les éléments d’une matrice.

– Interligne détermine l’espacement entre les lignes de la matrice ;

– Espacement entre les colonnes détermine l’espacement entre les colonnes de la matrice.

Symboles
Définissez ici l’espacement des symboles par rapport aux variables.

– Hauteur primaire définit la hauteur des symboles au-dessus de la ligne de base ;

– Espacement minimum détermine la distance minimum entre le symbole et la variable.

Opérateurs
Définissez ici l’espacement entre les opérateurs et les variables ou les nombres.

– Dépassement de taille détermine la hauteur du bord supérieur de la variable à celui de 
l’opérateur ;

– Espacement détermine la distance horizontale entre les opérateurs et les variables.

Bordures
Définissez la largeur des bordures autour d’une formule. Cette option est particulièrement 
utile si vous voulez intégrer la formule dans un document texte de Writer. Quand vous effec-
tuez les réglages, assurez-vous de ne pas utiliser 0 comme taille, car cela crée des pro-
blèmes d’affichage du texte qui entoure le point d’insertion.

– Gauche : la bordure gauche est située entre la formule et l'arrière-plan ;

– Droite : la bordure droite est située entre la formule et l'arrière-plan ;

– Haut : la bordure supérieure est située entre la formule et l'arrière-plan ;

– Bas : la bordure inférieure est située entre la formule et l'arrière-plan ;

Zone d’aperçu
Ce champ affiche un aperçu de la sélection courante.

Par défaut
Cliquer sur ce bouton pour enregistrer les modifications comme valeurs par défaut pour 
toutes les nouvelles formules. Un message vous demande confirmation avant d’enregistrer 
ces modifications.
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Ajuster l’alignement des formules

Les paramètres d’alignement déterminent la façon dont les éléments de formules situés les uns en
dessous des autres sont alignés horizontalement les uns par rapport aux autres.

Remarque

Il n’est pas possible d’aligner les formules sur un caractère particulier et l’alignement des for-
mules ne s’applique pas aux éléments textuels qui sont toujours alignés à gauche.

Remarque

Indépendamment de l’alignement proposé ci-dessous, il est possible d’aligner les formules 
grâce aux commandes alignl (alignement à gauche), alignc (centré) et alignr (aligne-
ment à droite) qui conviennent aussi pour les éléments textuels.

Alignement de la formule en cours

Pour modifier l’alignement utilisé par la formule en cours dans Math ou un autre module de 
LibreOffice :

 1) Cliquer sur le langage de balisage dans l’éditeur de formule.

 2) Sélectionnez Format > Alignement dans la barre de menu pour ouvrir la boîte de dialogue 
Alignement (Figure 10).

 3) Choisissez Gauche, Centré ou Droite comme alignement horizontal.

 4) Cliquez sur OK et contrôlez le résultat dans votre formule. S’il ne vous donne pas satisfac-
tion, reprenez les étapes précédentes.

Figure 10 : La boîte de dialogue Alignement

Alignement par défaut des formules

Pour modifier l’alignement utilisé par défaut par toutes les nouvelles formules dans Math et les 
autres modules de LibreOffice :

 1) Avant d’insérer une formule dans un document, sélectionnez Format > Alignement sur la 
barre de menu pour ouvrir la boîte de dialogue Alignement (Figure 10).

 2) Sélectionnez Gauche, Centré ou Droite comme alignement horizontal.

 3) Cliquez sur Par défaut et confirmez les modifications de l’alignement dans les formules. 
Toute formule créée à partir de ce moment utilisera le nouvel alignement.

 4) Cliquez sur OK pour enregistrer vos changements et fermer la boîte de dialogue Alignement.
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Remarque

Si vous avez déjà inséré des formules dans votre document et que vous modifiez les aligne-
ments par défaut, seules les formules insérées après la modification utiliseront le nouveau 
réglage. Vous devez modifier individuellement les alignements des formules déjà insérées si
vous voulez que celles-ci utilisent les alignements par défaut que vous venez de configurer.

Modifier la couleur dans une formule

La couleur des caractères

Pour modifier la couleur des caractères utilisés dans une formule, servez-vous de la commande 
color dans le langage de balisage. Celle-ci ne s’applique qu’à l’élément de formule qui suit immé-
diatement le nom de la couleur. Par exemple, saisir color red ABC 5 times 4 dans le lan-
gage de balisage donne le résultat ABC 5×4 .

Pour modifier la couleur de l’ensemble de la formule, vous devez l’encadrer par des accolades. 
Par exemple, le langage de balisage color red {ABC 5 times 4} donne le résultat
ABC 5×4 .

Pour plus d’informations sur les couleurs disponibles dans Math, voyez l’Annexe A, Référence des
commandes, du Guide Math.

Conseil

Pour vous faciliter la tâche, le volet des éléments comporte la catégorie Attributs qui pro-
pose la liste des couleurs standards. Cliquez sur la couleur désirée pour insérer la com-
mande dans votre formule.

La couleur d’arrière-plan

Il n’est pas possible de choisir une couleur de fond pour les formules dans LibreOffice Math. Par 
défaut, l’arrière-plan d’une formule a la couleur du document ou du cadre où la formule a été insé-
rée. Dans les documents de LibreOffice, vous pouvez cependant utiliser les propriétés des objets 
pour modifier la couleur de fond d’une formule. Pour plus d’informations sur l’utilisation d’une cou-
leur d’arrière-plan (remplissage pour les objets) avec une formule, veuillez vous reporter aux 
guides de Writer, Calc, Draw et Impress.

Bibliothèque de formules

Si vous insérez régulièrement les mêmes formules dans vos documents, vous pouvez créer une 
bibliothèque formules avec celles que vous avez créées dans l’éditeur de formule. Les formules 
peuvent être sauvegardées individuellement dans des fichiers au format ODF avec l’extension .odf
ou au format MathML avec l’extension .mml.

Vous pouvez utiliser les modules Math, Writer, Calc, Draw ou Impress de LibreOffice pour créer 
vos formules et bâtir votre bibliothèque.

Avec Math

 1) Créer un dossier sur votre ordinateur pour y ranger vos formules. Donnez-lui un nom facile à 
retenir, par exemple Bibliothèque de Formules.
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 2) Dans LibreOffice, sélectionnez Fichier > Nouveau > Formule dans la barre de menu ou cli-
quez sur Formule Math dans le centre de démarrage pour ouvrir Math et créer votre formule
avec l’éditeur de formule. Voyez « Les formules en tant que documents indépendants » 
page 2 pour plus d’informations.

 3) Sélectionnez Fichier > Enregistrer sous dans la barre de menu ou utilisez les touches de 
raccourcis Ctrl+Maj+S pour ouvrir la boîte de dialogue Enregistrer sous.

 4) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.

 5) Tapez un nom facile à retenir pour votre formule dans la zone de texte Nom de fichier.

 6) Dans la liste déroulante Type de fichier, choisissez soit Formule ODF (.odf) soit MathML 12.0
(.mml) comme type de fichier pour votre formule.

 7) Cliquez sur Enregistrer pour enregistrer votre formule et fermer la boîte de dialogue Enre-
gistrer sous.

Avec Writer, Calc, Draw ou Impress

 1) Créer un dossier sur votre ordinateur pour y ranger vos formules. Donnez-lui un nom facile à 
retenir, par exemple Bibliothèque de Formules.

 2) Ouvrez un document avec Writer, Calc, Draw ou Impress.

 3) Sélectionnez Insertion > Objet > Formule dans la barre de menu pour ouvrir l’éditeur de 
formule et créer la vôtre. Voyez « Les formules dans les documents de LibreOffice » 
page 1 pour plus d’informations.

 4) Faites un clic droit sur l’objet formule et cliquez sur Enregistrer la copie sous dans le menu 
contextuel pour ouvrir la boîte de dialogue Enregistrer sous.

 5) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.

 6) Tapez un nom facile à retenir pour votre formule dans la zone de texte Nom de fichier.

 7) Dans la liste déroulante Type de fichier, choisissez soit Formule ODF (.odf) soit MathML 12.0
(.mml) comme type de fichier pour votre formule.

 8) Cliquez sur Enregistrer pour enregistrer votre formule et fermer la boîte de dialogue Enre-
gistrer sous.

Utiliser votre bibliothèque de formules

Il n’est pas possible d’insérer une formule de votre bibliothèque dans un document par glisser-dé-
poser avec la souris ni en utilisant Insertion > Fichier dans la barre de menu. Il faut l’insérer dans 
votre document sous forme d’objet OLE.

 1) Ouvrez le document dans Writer, Calc, Draw ou Impress.

 2) Sélectionnez Insertion > Objet > Objet OLE dans la barre de menu pour ouvrir la boîte de 
dialogue Insérer un objet OLE.

 3) Cochez l’option Créer à partir d’un fichier.

 4) Cliquez sur Rechercher pour ouvrir la boîte de dialogue de recherche de fichiers.

 5) Recherchez le dossier que vous avez créé pour votre bibliothèque de formules.
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 6) Sélectionnez la formule que vous désirez insérer et cliquez sur Ouvrir ou faites un double-
clic sur la formule.

 7) Cliquez sur OK pour insérer la formule dans le document sous forme d’objet OLE et fermer 
la boîte de dialogue Objet OLE.

Conseil

Dans Writer, une autre méthode efficace pour insérer une formule régulièrement utilisée, 
consiste à créer un autotexte. Reportez-vous à la section sur l’autotexte au chapitre 4, Dé-
buter avec Writer du Guide du débutant.

Les formules dans Writer

Quand une formule est insérée dans un document, Writer la place dans un cadre et la traite 
comme un objet OLE. Un double-clic sur une formule insérée ouvre l’éditeur de formule dans Math
où vous pouvez la modifier.

Cette partie explique quelles options peuvent être modifiées pour chaque formule à l’intérieur d’un 
document Writer. Veuillez vous reporter aux chapitres sur les styles du Guide Writer pour toute in-
formation sur la manière de modifier les paramètres par défaut des styles de cadre des objets 
OLE.

Numérotation automatique des formules

La numérotation automatique des formules pour effectuer des renvois ne peut s’effectuer que dans
Writer. La façon la plus simple d’ajouter un numéro de référence à une formule consiste à utiliser 
l’autotexte nf (pour numéro de formule).

Numérotation

 1) Débuter une nouvelle ligne dans votre document

 2) Tapez nf puis appuyez sur la touche F3. Un tableau à deux colonnes, sans bordures, est in-
séré dans le document avec une formule d’exemple dans la colonne de gauche et un numé-
ro de renvoi dans celle de droite comme ci-dessous.

E=mc2 (1)

 3) Effacez la formule d’exemple et insérez la vôtre en tant qu’objet dans la colonne de gauche.

Vous pouvez aussi commencer par insérer votre formule dans le document puis effectuer les 
étapes 1 et 2 ci-dessus et remplacer la formule d’exemple par la vôtre.

Remarque

Si vous désirez utiliser des crochets à la place des parenthèses autour du numéro de la for-
mule ou si vous voulez que le numéro soit séparé de la formule par une tabulation plutôt que
placés dans un tableau, vous devrez modifier l’entrée d’autotexte pour nf. Reportez-vous à 
la section sur l’autotexte au chapitre 4 du Guide du débutant, Débuter avec Writer.
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Renvoi

 1) Cliquez dans le document où vous voulez faire apparaître le renvoi.

 2) Sélectionnez Insertion > Renvoi dans la barre de menu pour ouvrir la boîte de dialogue 
Champs (Figure 11).

Figure 11 : La boîte de dialogue Champs à la page Renvoi

 3) Cliquez sur l’onglet Renvoi puis sélectionnez Texte dans la section Type.

 4) Dans la partie Sélection, choisissez le numéro de formule auquel vous voulez renvoyer.

 5) Dans la partie Insérer une référence à, choisissez Référence et cliquez sur Insérer.

 6) Quand vous avez fini de créer des renvois, cliquez sur Fermer pour refermer la boîte de dia-
logue Champs.

Conseil

Pour insérer le numéro de référence sans parenthèses, choisissez Numérotation à la place 
de Référence dans la zone Insérer une référence à.

Ancrage des formules

Dans Writer, une formule est traitée comme un objet dont l’ancrage par défaut est Comme carac-
tère dans le paragraphe où elle est insérée dans un document. Pour modifier l’ancrage d’un objet 
formule :

 1) Faites un clic droit sur l’objet formule choisi et sélectionnez Ancrer dans le menu contextuel.
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 2) Choisissez une nouvelle option d’ancrage dans le sous-menu. Les possibilités sont À la 
page, Au paragraphe, Au caractère ou Comme caractère.

Vous pouvez aussi,

 1) Faire un clic droit sur l’objet formule et sélectionner Propriétés dans le menu contextuel ou 
choisir Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la boîte de 
dialogue Objet (Figure 12).

 2) Sélectionner l’onglet Type et choisir une nouvelle position d’ancrage dans la section Ancrer.

 3) Cliquer sur OK pour enregistrer les modifications et fermer la boîte de dialogue Objet.

Figure 12 : La boîte de dialogue Objet – Onglet Type avec les options d’ancrage

Remarque

Les options d’ancrage ne sont pas disponibles dans la boîte de dialogue Objet quand vous 
modifiez des styles de cadre. Pour plus d’informations sur la façon de modifier les styles de 
cadres, veuillez vous reporter aux chapitres sur les styles dans le Guide Writer.

Alignement vertical

L’alignement vertical par défaut pour les objets formules utilise la ligne de base du texte comme ré-
férence. Ce paramétrage par défaut peut être changé en modifiant le style de cadre des formules. 
Voyez les chapitres sur les styles dans le Guide Writer pour plus d’informations.

Pour modifier l’alignement vertical d’un objet formule unique (en supposant que l’option d’ancrage 
choisie est Comme caractère) :

 1) Faites un clic droit sur la formule et sélectionnez Propriétés dans le menu contextuel ou sé-
lectionnez Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la boîte
de dialogue Objet (Figure 12).
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 2) Sélectionnez l’onglet Type et choisissez un nouvel alignement dans la liste déroulante Verti-
cal de la section Position. Les options possibles sont Haut, Bas, Centre et Du bas.

 3) Si nécessaire, tapez un décalage positif ou négatif d’alignement vertical dans la zone de sai-
sie. Cette possibilité n’est offerte que si l’alignement Du bas a été choisi.

 4) Choisissez le type d’alignement par rapport au texte dans la liste déroulante à droite de la 
section Position. Les choix disponibles sont Ligne de base, Caractère et Ligne.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Remarque

Si la section Position de la boîte de dialogue Objet est grisé et inaccessible, sélectionnez 
Outils > Options dans la barre de menu pour ouvrir la boîte de dialogue Options, puis ou-
vrez la page LibreOffice Writer – Aide au formatage et décochez l’option Alignement de la 
ligne de base Math. Ce paramètre est stocké avec le document et s’applique à toutes les 
formules qu’il contient. Tout nouveau document utilisera aussi ce paramétrage.

Espacement des objets

Un objet formule, une fois inséré dans un document Writer, possède un espacement de chaque 
côté. La valeur par défaut utilisée pour celui-ci est définie dans le style de cadre des formules et 
peut être modifiée en changeant ce style, voyez les chapitres sur les styles dans le Guide de 
Writer pour plus d’informations.

Vous pouvez ajuster séparément l’espacement de chaque objet formule à l’intérieur d’un document
de la manière suivante :

 1) Créez la formule dans votre document Writer.

 2) Faites un clic droit sur l’objet formule et sélectionnez Propriétés dans le menu contextuel ou 
sélectionnez Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la 
boîte de dialogue Objet.

Figure 13 : La boîte de dialogue Objet – Onglet Adapter
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 3) Cliquez sur l’onglet Adapter (Figure 13).

 4) Dans la section Espacement, saisissez les valeurs d’espacement pour Gauche, Droite, Haut
et Bas.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Le mode texte

Quand une grande formule est placée dans une ligne de texte, ses éléments peuvent souvent dé-
passer la hauteur du texte. Pour qu’elles soient plus faciles à lire, il est donc recommandé de tou-
jours insérer les formules de grande hauteur dans un paragraphe indépendant pour la séparer du 
reste du texte.

Cependant, s’il s’avère nécessaire de placer une grande formule dans une ligne de texte, faites un 
double-clic sur celle-ci pour ouvrir l’éditeur de formule puis sélectionnez Format > Mode Texte 
dans la barre de menu. L’éditeur de formule va alors essayer de la compresser pour la faire tenir 
dans la hauteur du texte. Les numérateurs et dénominateurs des fractions sont réduits et les li-
mites des intégrales et des sommes sont placées à côté du signe intégral ou somme comme le 
montre l’exemple suivant.

Exemple

Une formule dans un paragraphe séparé :

∑
i=2

5

i2

et la même formule incorporée dans une ligne de texte grâce au mode texte : ∑i=2
5 i2

Arrière-plan et bordures

Le paramétrage par défaut de l’arrière-plan (zone) et des bordures pour les objets formules est dé-
fini dans le style de cadre des formules et peut être modifié en changeant ce style, voyez les cha-
pitres sur les styles dans le Guide Writer pour plus d’informations. Vous pouvez cependant modi-
fier individuellement l’arrière-plan et les bordures des formules de votre document.

Remarque

La taille du cadre dans lequel une formule est placée quand elle est insérée dans un docu-
ment ne peut pas être modifiée. Elle dépend du paramétrage de la taille de police de la for-
mule ; voyez « Créer des formules », page 3, et « Éditer les formules », page 8, pour plus
d’informations.

Arrière-plans

 1) Sélectionnez dans le document la formule dont vous désirez modifier l’arrière-plan.

 2) Faites un clic droit sur l’objet formule et sélectionnez Propriétés dans le menu contextuel ou 
sélectionnez Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la 
boîte de dialogue Objet.

 3) Cliquez sur l’onglet Zone et choisissez le type de remplissage que vous désirez utiliser pour 
la formule (Figure 14).
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 4) Sélectionnez les options que vous voulez appliquer au fond de la formule. Celles-ci dé-
pendent du type de remplissage choisi.

 5) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Figure 14 : La boîte de dialogue Objet – Onglet Zone proposant une couleur de fond.

Bordures

 1) Sélectionnez dans le document la formule dont vous désirez modifier les bordures.

 2) Faites un clic droit sur l’objet formule et sélectionnez Propriétés dans le menu contextuel ou 
sélectionnez Format > Cadre et objet > Propriétés dans la barre de menu pour ouvrir la 
boîte de dialogue Objet.

 3) Cliquez sur l’onglet Bordures et sélectionnez les options que vous désirez appliquer aux bor-
dures de la formule (Figure 15).

 4) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.
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Figure 15 : La boîte de dialogue Objet – Onglet Bordures

Insertion rapide de formules

Pour insérer rapidement une formule dans un document Writer sans ouvrir l’éditeur de formule 
quand vous connaissez le langage de balisage de cette formule :

 1) Saisissez le langage de balisage de la formule dans le document à l’endroit où vous voulez 
voir apparaître la formule.

 2) Sélectionnez la formule en langage de balisage.

 3) Choisissez Insertion > Objet dans la barre de menu et sélectionnez Formule pour créer 
une formule à partir de la sélection.

Les formules dans Calc, Draw et Impress

Dans Calc, Draw et Impress, les formules sont insérées sous forme d’objets OLE sans arrière-plan
ni bordures. Chaque objet formule est inséré dans un classeur, un dessin ou une diapositive de la 
façon suivante :

• Dans Calc, les formules sont insérées dans une cellule sélectionnée d’un classeur sans 
qu’un style lui soit affecté.

• Dans Draw et Impress, les formules sont insérées en position centrale dans votre dessin ou 
votre diapositive et elles reçoivent par défaut le style Objet sans remplissage et sans ligne. 
Pour plus d’information sur la façon de modifier ou d’affecter des styles aux objets dessinés, 
voyez le Guide Draw ou le Guide Impress.
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Ancrage des formules

Dans Calc

Un objet formule peut être ancré dans un classeur À la page (paramétrage par défaut) ou À la cel-
lule. Pour modifier le type d’ancrage d’une formule dans un classeur :

 1) Sélectionnez l’objet formule dans votre classeur.

 2) Faites un clic droit sur la formule et choisissez Ancrage > À la page ou À la cellule dans le 
menu contextuel.

Vous pouvez aussi sélectionner Format > Ancrer dans la barre de menu et choisir À la 
page ou À la cellule.

Dans Draw et Impress

Une formule est insérée dans un dessin ou une diapositive comme objet OLE flottant et ne pos-
sède pas d’ancrage à une position particulière dans le dessin ou la diapositive.

Propriétés des objets formules

Les objets formules dans Calc, Draw et Impress peuvent être modifiés exactement comme tout 
autre objet placé dans un classeur, un dessin ou une présentation, à l’exception de la taille et du 
format du texte à l’intérieur de la formule. Pour plus d’information sur la manière de modifier les 
propriétés des objets, voyez le Guide Calc, le Guide Draw ou le Guide Impress.

Les points suivants vous aideront à choisir la boîte de dialogue à utiliser pour modifier les proprié-
tés des objets formules.

• Pour l’arrière-plan des formules, utilisez les différentes options de la boîte de dialogue Rem-
plissage.

• Pour les bordures des formules, utilisez les différentes options de la boîte de dialogue Ligne. 
Notez que les bordures des formules sont distinctes des bordures des cellules dans un clas-
seur de Calc.

• Pour positionner avec précision un objet formule, utilisez les différentes options des pages 
de la boîte de dialogue Position et taille.

• Dans Draw et Impress, vous pouvez disposer, aligner, grouper, retourner, convertir, dissocier,
combiner et éditer les points des objets formules.

• Vous ne pouvez pas modifier les attributs du texte d’un objet formule. Celui-ci est défini 
quand vous créez la formule dans l’éditeur de formule.

• La taille d’un objet formule est définie par la taille de la police utilisée quand la formule est 
créée dans l’éditeur de formule. Elle est protégée dans la boîte de dialogue Position et taille, 
mais vous pouvez décocher cette protection si vous le désirez. Ce n’est cependant pas re-
commandé, car la modification de l’objet dans ce dialogue peut produire des distorsions qui 
rendront la formule difficile à lire.

Des formules dans les diagrammes

Un diagramme dans un classeur de Calc est lui-même un objet OLE : vous ne pouvez donc pas 
utiliser l’éditeur de formule pour créer et insérer une formule dans un diagramme.
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Pour insérer une formule dans un diagramme, commencez par créer la formule grâce à l’éditeur de
formule et copiez-la dans le presse-papier. Créez ensuite le diagramme dans Calc et collez la for-
mule dans le diagramme. Elle est automatiquement convertie dans le format convenable pour une 
insertion dans un diagramme.

Si vous désirez à un autre moment modifier la formule, vous devez répéter tout le processus de 
création, copie et collage.

Personnalisation

Cette section explique comment vous pouvez personnaliser Math pour l’adapter à votre façon de 
créer des formules utilisées dans les documents de LibreOffice. Veuillez aussi vous reporter au 
chapitre 14, Personnaliser LibreOffice, de ce guide pour plus d’informations générales sur la façon 
de personnaliser LibreOffice.

Formules chimiques

L’objet principal de Math est la création de formules mathématiques, mais on peut aussi l’utiliser 
pour écrire des formules chimiques. Cependant, les symboles utilisés dans les formules chimiques
sont habituellement écrits en majuscules et en caractères droits (non italiques). Le tableau suivant 
montre quelques exemples de formules chimiques.

Construction Exemple Langage de balisage

Molécules H2 SO4
H_2 SO_4

Isotopes U92
238 U lsub 92 lsup 238

Ions SO4
2−  ou SO4

2- SO_4^{ 2-{} } ou SO_4^{ 2"-" }

Pour créer des formules chimiques avec Math, vous devrez changer la police utilisée pour les va-
riables pour une police non italique. Pour plus d’informations, voir « Polices des formules », page
17.

Math ne propose pas de symbole de flèche double que vous pourriez utiliser pour des réactions ré-
versibles. Si vous disposez d’une police qui offre le symbole correct pour les réactions chimiques 
réversibles, vous pouvez l’ajouter au catalogue. Voir « Personnaliser le catalogue », page 35 
pour plus d’informations sur la façon d’ajouter des symboles au catalogue.

Boîtes de dialogues flottantes

L’éditeur de formules et le volet des éléments peuvent couvrir une grande partie de votre docu-
ment. Pour vous aider à dégager de l’espace ou vous permettre de déplacer l’éditeur de formule 
ou le volet des éléments à un autre endroit, vous pouvez les transformer en boîtes de dialogue flot-
tantes.

 1) Placez le pointeur de la souris au-dessus du cadre.

 2) Appuyez sur la touche Ctrl et faites un double-clic sans la relâcher. L’éditeur de formules 
devient alors la boîte de dialogue Commandes (Figure 16) et le volet des éléments la boîte 
de dialogue Éléments (Figure 17).
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Figure 16 : La boîte de dialogue Commandes

Figure 17 : La boîte de dialogue Éléments

Pour replacer les boîtes de dialogue Commandes et Éléments à leurs positions initiales :

 1) Placer le pointeur de la souris au-dessus de l’encadrement de la boîte de dialogue, mais pas
sur la barre de titre en haut de celui-ci.

 2) Appuyez sur la touche Ctrl et faites un double-clic sans la relâcher.

Ajouter des raccourcis clavier

Vous pouvez ajouter à LibreOffice des raccourcis clavier adaptés à votre méthode de travail pour 
faciliter la création de documents. Voyez le chapitre 14, Personnaliser LibreOffice, pour la méthode
à employer.

Personnaliser le catalogue

Si vous utilisez régulièrement un symbole qui n’est pas disponible dans Math, vous pouvez l’ajou-
ter à la boîte de dialogue Symboles (Figure 18) en ouvrant la boîte de dialogue Éditer les sym-
boles (Figure 19).

Grâce à celle-ci, vous pouvez ajouter des symboles à un jeu de symboles, les modifier ou modifier 
la notation d’un symbole. Vous pouvez aussi définir un nouveau jeu de symboles, leur affecter des 
noms ou modifier les jeux de symboles existants.

Ajouter de symboles

 1) Sélectionnez Outils > Symboles dans la barre de menu ou cliquez sur l’icône Symboles 
dans la barre d’outils Outils pour ouvrir la boîte de dialogue Symboles.
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Figure 18 : La boîte de dialogue Symboles

 2) Cliquez sur le bouton Éditer pour ouvrir la boîte de dialogue Éditer les symboles (Figure 19).

Figure 19 : La boîte de dialogue Éditer les symboles

 3) Choisissez une police dans la liste déroulante Police.

 4) Sélectionnez le caractère ou le symbole que vous souhaitez ajouter dans la liste qui occupe 
la plus grande partie de la boîte de dialogue. Vous aurez peut-être à la faire défiler pour trou-
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ver celui qui vous intéresse. Une petite fenêtre d’aperçu, en bas à droite, affiche le nouveau 
symbole.

 5) Dans le champ Symbole, saisissez un nom significatif pour le symbole que vous ajoutez.

 6) Dans le champ Jeu de symboles, choisissez dans la liste déroulant le jeu de symboles au-
quel le nouveau viendra s’ajouter ou saisissez un nouveau nom pour créer un nouveau jeu 
pour le nouveau symbole.

 7) Si nécessaire, choisissez un style de police dans la liste déroulante Style, parmi les choix 
Standard, Italique, Gras et Gras, italique.

 8) Cliquez sur le bouton Ajouter puis sur le bouton OK pour refermer la boîte de dialogue Édi-
ter les symboles. Le nouveau symbole et, éventuellement, le nouveau jeu de symboles sont 
désormais disponibles.

Remarque

Quand un nouveau symbole est ajouté au catalogue, vous pouvez taper, dans le langage de
balisage de l’éditeur de formule, un caractère pourcent (%) suivi par le nom que vous avez 
choisi pour que ce symbole apparaisse dans votre formule. N’oubliez pas les noms des 
symboles distinguent les majuscules des minuscules : par exemple %prime ne représente 
pas le même symbole que %Prime.

Remarque

Si vous ne trouvez pas le symbole désiré parmi les polices déjà installées sur votre ordina-
teur, Il existe de nombreuses polices libres qui contiennent plusieurs symboles. La police 
STIX, par exemple, a été développée spécialement pour l’écriture de textes mathématiques 
et techniques. De même, les polices DejaVu et Lucida vous offrent une large gamme de 
symboles.

Remarque

Quand LibreOffice est installé sur un ordinateur, seuls les symboles définis par l’utilisateur et
réellement utilisés dans le document sont enregistrés avec lui. Il est parfois utile d’incorporer
tous les symboles définis par l’utilisateur pour que le document puisse être édité par quel-
qu’un d’autre une fois transféré sur un autre ordinateur. Sélectionnez Outils > Options > 
LibreOffice Math > Paramètres et décochez l’option Incorporer uniquement les symboles 
utilisés (taille de fichier inférieure). Ce réglage n’est accessible que si vous travaillez avec 
Math.

Modifier le nom des symboles

Vous pouvez changer le nom d’un symbole de la façon suivante :

 1) Sélectionnez le nom du symbole que vous voulez modifier dans la liste déroulante Ancien 
Symbole. Le symbole apparaît dans le panneau d’aperçu de gauche, en bas de la boîte de 
dialogue Éditer les symboles (Figure 19).

 2) Saisissez un nouveau nom pour le symbole dans le champ de saisie Symbole où choisissez-
le dans la liste déroulante associée. Le nouveau nom du symbole apparaît au-dessus du 
panneau d’aperçu de droite en bas de la boîte de dialogue Éditer les symboles.
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 3) Cliquez sur le bouton Modifier pour appliquer le changement de nom.

 4) Cliquez sur le bouton OK pour refermer la boîte de dialogue Éditer les symboles.

Déplacer des symboles

Vous pouvez déplacer un symbole d’un jeu de symbole à un autre de la façon suivante :

 1) Dans la liste déroulante Ancien jeu de symbole, sélectionnez le jeu de symbole où se trouve 
le symbole que vous voulez déplacer.

 2) Sélectionnez le nom du symbole que vous voulez déplacer dans la liste déroulante Ancien 
Symbole. Le symbole apparaît dans le panneau d’aperçu de gauche, en bas de la boîte de 
dialogue Éditer les symboles (Figure 19).

 3) Dans la liste déroulante Jeu de symbole, choisissez le jeu de symboles où vous voulez dé-
placer le symbole choisi. Le nom du nouveau jeu de symboles apparaît sous le panneau 
d’aperçu de droite en bas de la boîte de dialogue Éditer les symboles.

 4) Cliquez sur le bouton Modifier pour appliquer le déplacement du symbole.

 5) Cliquez sur le bouton OK pour refermer la boîte de dialogue Éditer les symboles.

Supprimer des symboles

Vous pouvez supprimer un symbole d’un jeu de symbole de la façon suivante :

 1) Dans la liste déroulante Ancien jeu de symbole, sélectionnez le jeu de symbole où se trouve 
le symbole que vous voulez supprimer.

 2) Sélectionnez le nom du symbole que vous voulez supprimer dans la liste déroulante Ancien 
Symbole. Le symbole apparaît dans le panneau d’aperçu de gauche, en bas de la boîte de 
dialogue Éditer les symboles (Figure 19).

 3) Cliquez sur le bouton Supprimer pour supprimer le symbole sans confirmation.

 4) Cliquez sur le bouton OK pour refermer la boîte de dialogue Éditer les symboles.

Remarque

La seule façon de supprimer un jeu de symboles consiste à en supprimer tous les symboles.
Lors de la suppression du dernier symbole, le jeu est aussi supprimé.

Options d’édition des symboles

Ancien symbole
Choisissez ici le nom du symbole courant. Ce symbole, son nom et le jeu auquel il appartient
sont affichés dans le panneau d’aperçu de gauche en bas de la boîte de dialogue Éditer les 
symboles.

Ancien jeu de symboles
Ce champ affiche le nom du jeu de symbole courant. Vous pouvez aussi en sélectionner un 
autre grâce à la liste déroulante associée.

Symbole
Saisissez ici le nom d’un symbole que vous allez ajouter ou choisissez-le dans la liste dérou-
lante associée, qui contient les noms de tous les symboles du jeu courant.
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Jeu de symboles
Saisissez ici le nom du nouveau jeu de symbole auquel vous voulez ajouter un nouveau 
symbole ou choisissez-le dans la liste déroulante associée, qui contient les noms de tous les
jeux de symboles existants.

Police
Ce champ affiche le nom de la police courante et vous permet d’en choisir une autre.

Sous-ensemble
Si vous avez sélectionné une police qui ne contient pas que des symboles dans le champ 
Police, vous pouvez choisir ici un sous-ensemble Unicode dans lequel se trouve votre sym-
bole nouveau ou modifié. Quand ce sous-ensemble a été choisi, la liste Symbole propose 
tous les symboles appartenant à ce sous-ensemble du jeu de symboles courant.

Style
Ce champ affiche le style de police courant et vous permet d’en choisir un autre dans la liste 
déroulante associée.

Ajouter
Cliquez sur ce bouton pour ajouter le symbole affiché dans le panneau d’aperçu de droite au 
jeu de symboles courants. Il sera enregistré sous le nom affiché dans le champ Symbole. 
Vous devez spécifier un nom dans Symbole ou Jeu de symboles pour que ce bouton soit ac-
cessible. Les noms ne peuvent pas être utilisés plusieurs fois.

Modifier
Cliquez sur ce bouton pour remplacer le nom du symbole affiché dans le panneau d’aperçu 
de gauche (l’ancien nom est affiché dans le champ Ancien symbole) par le nouveau nom que
vous avez saisi dans le champ Symbole.

Supprimer
Cliquez sur ce bouton pour supprimer le symbole affiché dans le panneau d’aperçu de 
gauche du jeu de symboles courants. Aucune confirmation n’est demandée avant suppres-
sion. Supprimer le dernier symbole d’un jeu de symboles supprime aussi celui-ci.

Annuler
Cliquez sur ce bouton quand vous voulez refermer la boîte de dialogue sans enregistrer les 
changements effectués.

Espacement dans les formules

L’accent grave (` : touche Alt Gr+è sous Windows) insère un petit espace et le tilde (~ : touche 
Alt Gr+é sous Windows) un espace large supplémentaire dans les formules. Cependant, dans 
l’installation de base de LibreOffice, ces symboles sont ignorés quand ils se trouvent à la fin d’une 
formule. Si vous travaillez avec du texte courant dans une formule, il peut être nécessaire d’inclure
aussi un espacement à la fin de la formule. Cette personnalisation n’est nécessaire que si vous 
travaillez avec des documents Math, mais pas si vous insérez une formule dans un autre compo-
sant de LibreOffice.

Pour ajouter un espacement à la fin des formules dans Math, sélectionnez Outils > Options > 
LibreOffice Math > Paramètres dans la barre de menu et décochez l’option Ignorer ~ et ` en fin 
de ligne dans la section Autres options.
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Extensions

Si vous créez fréquemment des formules dans vos documents, vous pouvez personnaliser 
LibreOffice en ajoutant des extensions conçues pour aider à la création de formules. Elles sont fa-
ciles à installer en utilisant le Gestionnaire des extensions. Pour plus d’informations sur ce sujet, 
voyez le chapitre 14 du Guide du débutant.

Dmaths est une extension dont l’installation est recommandée ; elle est conçue pour être utilisée 
dans Writer auquel elle ajoute un ensemble de macros mathématiques qui offrent cinq barres d’ou-
tils pour la création de formules. Pour plus d’informations sur cette extension, voyez le site web 
http://www.dmaths.org.

Une deuxième extension recommandée, Formatting of All Math Formulas, vous permet de for-
mater toutes les formules de Math dans votre document Writer, Calc, Draw ou Impress. Vous pou-
vez modifier la police et la taille des caractères de toutes les formules ou de celles qui sont sélec-
tionnées. Pour plus d’informations sur cette extension, voyez le site web https://extensions.libreof-
fice.org/en/extensions/show/formatting-of-all-math-formulas (en anglais).

Exportation et importation

Le format MathML

En plus de l’exportation des documents en fichiers PDF, LibreOffice offre la possibilité d’enregistrer
les formules au format MathML. Cela vous permet, ou à quelqu’un d’autre, d’insérer des formules 
dans des documents, comme si elles avaient été créées dans un autre logiciel, par exemple, 
Microsoft Office ou un navigateur internet.

Remarque

Certains navigateurs internet ne soutiennent pas totalement le format MathML et votre for-
mule peut ne pas s’afficher correctement.

Si vous travaillez sur un document Math, sélectionnez Fichier > Enregistrer sous dans la barre 
de menu ou utilisez le raccourci clavier Ctrl+Maj+S pour ouvrir la boîte de dialogue Enregistrer 
sous. Sélectionnez MathML 2.0 dans la liste des formats de fichier disponibles pour enregistrer 
votre formule dans ce format.

Si vous travaillez dans un autre composant de LibreOffice, faites un clic droit sur l’objet formule et 
choisissez Enregistrer la copie sous dans le menu contextuel pour ouvrir la boîte de dialogue 
Enregistrer sous. Sélectionnez MathML 2.0 dans la liste des formats de fichier disponibles pour en-
registrer votre formule dans ce format.

Dans Math, vous pouvez aussi importer une formule MathML et sélectionnant Outils > Importer 
MathML depuis le presse-papiers dans la barre de menu.

Les formats de fichier Microsoft

Pour contrôler la façon dont les formules au format Microsoft sont importées et exportées par 
LibreOffice, sélectionnez Outils > Options > Chargement/Enregistrement > Microsoft Office 
dans la barre de menu et cochez ou décochez les options MathType à LibreOffice Math ou inver-
sement.
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• [C]  : Charger et convertir l’objet ;

• [E]  : Convertir et enregistrer l’objet.

[C] Charger et convertir l’objet

Cochez cette option si des objets OLE Microsoft doivent être convertis en objets OLE LibreOffice 
quand un document est ouvert dans LibreOffice. Pour les formules, les objets incorporés ne 
doivent pas excéder la version 3.1 de MathType pour pouvoir être chargés avec succès et conver-
tis. Vous pouvez trouver des informations sur le format MathType sur le site web http://www.dess-
ci.com/en (en anglais).

[E] Convertir et enregistrer l’objet

Cochez cette option si des objets OLE LibreOffice doivent être convertis et enregistrés dans un for-
mat de fichier Microsoft. LibreOffice convertit toutes les formules dans un format qui peut être lu et 
modifié par l’éditeur d’équation de Microsoft et par MathType.

Quand cette option n’est pas cochée, la formule est traitée comme un objet OLE à la conversion 
en format .doc et reste liée à LibreOffice. Un double-clic sur l’objet dans Microsoft Office provoque-
ra une tentative de lancement de LibreOffice.
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